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1. Overview

1.1. MX3G PLC HMI All in one Main Advantage:

◆PLC programming software is compatible with GX Developer8.86/GX

Works2

(supports Ladder diagram and SFC language, does not support structured

programming/labels).

HMI uses TP HMI's programming software TPWorks.

◆Powerful, compatible with FX3S PLC, high processing speed.

◆Military level 32 bit CPU adopted, which is faster and more adapted to

industrial environment of high electromagnetic interference.

◆Special encryption, prevent illegal reading thoroughly. 8-bit encryption,

12345678 as password can thoroughly prevent reading of ladder logic

program.

◆Default with 1 HMI download port and two PLC programming ports

(RS232/Type-C).

◆The PLC of the MX3G-70C all-in-one machine comes with 1 RS485; the

HMI comes with 1 RS232, which can be changed to 1 RS485; the PLC of the

MX3G-43C all-in-one machine comes with 1 RS485; the HMI comes with 1

RS232. They are used for external HMI and inverters and other equipment.

◆Support Mitsubishi programming port protocol/MODBUS protocol/RS

protocol, easily realize PLC interconnection and communication with external

equipment.

◆High-speed counting conventional 2 single-phase 60KHz + 4 10KHz or 1

AB (Z) phase 30KHz +1 AB (Z) phase 5KHz; high-speed pulse conventional 4

channels: For 70C, Y0-Y1 is 100KHz, Y2-Y3 is 50KHz; For 43C, Y0-Y1 is

100KHz, Y2-Y3 is 10KHz; high-speed counting + high-speed pulse total

transmission cannot exceed 300KHz; acceleration and deceleration are

independent.
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◆Support multiple types analog individually or mixed ones for analog output

and input. MX3G-70C is up 9AD2DA, MX3G-43C is up to 5AD2DA. The

precision of analog input and output is 12 bits.

◆MX3G-70C is up to 24DI/24DO (MR: 12 at most), digital output can be

optional transistor MT (maximum load 500mA) or relay and transistor mixed

output MRT. MX3G-43C is up to 12DI/10DO (MR: 8 at most), digital output

optional transistor MT (Max load: 500mA) or relay and transistor mixed output

MRT.

◆Convenient wiring. All wiring terminals adopt 3.81 pitch pluggable

terminals, which is convenient for customers to use.

◆Flexible, more specifications and batches can be customized according to

customer requirements.
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1.2. Product parameters
Model MX3G-43C-22M MX3G-70C-48M

Im
age

Dimensions 134*102*34mm 210*146*36mm
Cutout size 120*94mm 192*138mm
Power

consumption
4-6W 6-7W

HMI
Feature 60K colors resistive touch screen, supports portrait display
Type 4.3"TFT 7.0"TFT

Display size 97*56mm 154*87mm
Resolution
(pixels)

480*272 800*480/1024*600

RAM 64MB
ROM NOR Flash 8MB NOR Flash 16MB
CPU 32bit CPU 408MHz

COM
Type-C (HMI download port); PLC program can be downloaded through the USB penetrating function of

HMI
1 RS232 on HMI

Software TPWorks HMI software
PLC

I/O Max 12DI 10DO (2T8R) Max 24DI 24DO (12T12R)

I/O level

43C Y0, Y1 and 70C Y0-Y13 fixed MT output, DC24V active NPN output;
Other output MT: low level NPN, COM connected to negative;
Output MR: normally open dry contact;
Input: Passive NPN, common terminal isolation

DO type and
load

Transistor MT/Mixed output MRT
The first 2 channels Y0-Y1 are fixed as MT, and

the output load is 0.1A/point;
MT: 0.5A/point, 0.8A/4point COM;
MR: 2A/point, 4A/4 points COM.

Transistor MT/Mixed output MRT
The first 12 channels Y0-Y13 are fixed as MT, and

the output load is 0.1A/point;
MT: 0.5A/point, 0.8A/4-point COM, 1.6A/8-point

COM;
MR: 2A/point, 4A/4-point COM, 5A/8-point COM.

High-speed
counting

Conventional 2-channel single-phase 60KHz+4 channels 10KHz or 1 channel AB(Z) phase 30KHz +1
channel AB(Z) phase 5KHz

High-speed
pulse

MT output conventional 4 channels Y0-Y1 is
100KHz, Y2-Y3 is 10KHz;

High-speed counting + high-speed pulse total

Conventional 4-channel Y0-Y1 is 100KHz, Y2-Y3
is 50KHz;

High-speed counting + high-speed pulse total

http://www.coolmay.com/webdown/TPWorks.exe
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transmission cannot exceed 300KHz transmission cannot exceed 300KHz

Anal
og

Input Comes with 2 channels of voltage 0-10V+2 channels of current 0-20mA+1 channel NTC10K

Output
Comes with 1 voltage 0-10V + 1 current 0-20MA

output
Comes with 2 current 0-20MA outputs

Analog
I/O

5AI 2AO

COM
Comes with two PLC programming ports (1 TYPE-C, faster download speed; 1 RS232 programming port)

Comes with 1 RS485

Software
Compatible with PLC programming software GX Developer8.86Q And

GX Works2

customize

Customization conditions: 200 sets and above can be customized
①HMI needs to store historical data, you can

customize ferroelectric
②PLC can customize 4-way EKSTJ type

thermocouple (support negative temperature)
(Note: Thermocouple and its own current and

voltage cannot coexist)

①HMI needs to store historical data, you can
customize ferroelectric

②HMI can be customized with a RS485 (cannot
coexist with the built-in RS232)

③PLC can customize 4-way EKSTJ type
thermocouple (support negative temperature)

Suggested models:MX3G-43C-22MT/22MRT-5AD2DA-232H/485P
MX3G-70C-48MT/48MRT-5AD2DA-232H/485P；

http://www.coolmay.com/webdown/GXDeveloper-8.86Q.rar
https://pan.baidu.com/s/1mi6Lyti?errno=0&errmsg=Auth%20Login%20Sucess&stoken=bc0c86935640cd5b447d5d4a74206102cd22edb85b0681089dd38d51d40ddf64a68c1ede514f87d26dd904a8d288ac166702262ed15309b2ca1eaa2b0e6460c24d44750f9c38&bduss=a6a71f31177f8e0ee82075d300bf8d0c


COOLMAY MX3G PLC HMI All in one Programming manual

5

1.3. Hardware description

1.3.1. MX3G-43C structure and size

PLC running indicator Communication indicator Power indicator

Dimensions (mm): 134*102*34

Cutout size (mm): 120*94

Display size (mm): 97*56

Installation method: Clip installation
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1.3.2. MX3G-70C structure and size

PLC running indicator Communication indicator Power indicator

Dimensions (mm):210*146*36

Cutout size (mm): 192*138

Display size (mm): 154*87

Installation method: Clip installation
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1.3.3. Introduction of each interface and indicator

POWER: Power indicator, connected to the power light

RUN: PLC running status indicator. This light is on when the PLC is running.

COM: touch screen and PLC communication status indicator, when the two

communicate, the light is on

Power terminal: The positive and negative terminals of the DC24V switching

power supply are respectively connected to the DC24V and 0V of the power

supply terminal.

PLC programming port: two PLC programming ports (Type-C and RS232),

PLC program can be downloaded through 232 programming line or USB cable

download

Touch screen programming port: download touch screen configuration

program

For other hardware information, refer to“MX3G HMI PLC All-in-one User

Manual”
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2. PLC

2.1. PLC Programming notice

The PLC is compatible with GX Developer8.86/GX Works2 and below. If you

use other versions of software, incompatibility may occur.

When the PLC program is downloaded, there is a prompt error: Cannot

specify the com port,

GX 8.86 software: Online-Transfer settings change com port;

Works 2: All targets-Change the com port in all connected targets;

If there is a communication abnormality, cable abnormality and other

prompts, remove it by cutting off the power, checking the cable, checking

whether the power supply is normal, or replacing the computer.

In the GX Developer8.86 software version, choose the figure:

In the Works 2 software version, choose the figure: (Note: the label is

forbidden)
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2.2. Soft element table
Name Contents
I/O relay
Input relay X000～X027 24 points Soft element number is octal

Total 48 points for I/OOutput relay Y000～Y027 24 points
Auxiliary relay
General M0～M383 384 points
EEPROM hold M384～M511 128 points
General M512～M1535 1024 points
Special M8000～M8511 512 points
Status
Initial state (EEPROM

hold)
S0～S9 10 points

EEPROM hold S10～S127 118 points
General S128～S255 128 points
Timer (ON delay timer)
100ms T0～T31 32 points 0.1～3,276.7s

100ms/10ms※1 T32～T62 31 points

0.1～3,276.7s/0.01～327.67s
After M8028 is turned ON, T32

～ T62 can be changed into 10ms
timer

1ms T63～T127 65 points 0.001～32.767s

1ms accumulative
(EEPROM hold)

T128～T131 4 points 0.001～32.767s

100ms accumulative
(EEPROM hold)

T132～T137 6 points 0.1～3,276.7s

Counter
General up counter (16bit) C0～C15 16 points 0～32,767 counter
EEPROM hold up counter
(16 bit)

C16～C31 16 points 0～32,767 counter
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General bi-direction (32
bit)

C200～C234 35 points
-2,147,483,648～+2,147,483,647

counter
High-speed counter
Single-phase single

counter input
Bi-direction (32 bit)

(EEPROM hold)

C235～C245
-2,147,483,648～+2,147,483,647 counter
Software counter
Single phase: up to 6 channels, maximum

frequency 60kHz
Double phase: 1 times frequency: at most 2

channels, Max frequency 30KHz
4 times frequency: at most 2

channels, Max frequency 24kHz
M8198 is the 4 times frequency sign of C251
M8199 is the 4 times frequency sign of C253

Single-phase double
counter input
Bi-direction (32 bit)

(EEPROM hold)

C246～C250

Double –phase double
counter input
Bi-direction (32

bit)(EEPROM hold)

C251～C253

Data register(32 bit when using in pair)

General(16bit)
D0～D127
D256～D999

872 points

EEPROM hold (16 bit)
D128～D255
D1000～D3999

3128 points

General(16bit) D256～D2999 2744 points
Special (16 bit) D8000～D8511 512 points
Index (16 bit) V0～V7,Z0～Z7 16 points
Pointer
JUMP,CALL branch P0～P255 256 points CJ instruct、CALL instruct
Input interrupt I0□□～I5□□ 6 points
Timer interrupt I6□□～I8□□ 3 points
Nest
Master control N0～N7 8points MC instruct
Constant

Decimal (K)
16 bit -32,768～+32,767
32 bit -2,147,483,648～+2,147,483,647

Hexadecimal (H)
16 bit 0000～FFFF
32 bit 00000000～FFFFFFFF

Real number(E)
32 bit

-1.0×2128～-1.0×2-126,0,1.0×2-126～1.0×2128
Can be in the form of a decimal point and index

*1: The 10ms timer will be affected by the scan cycle. If the scan period is 12ms, the

timer becomes 12ms and is executed once.
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2.3. Special relay number and content
No. Content Remarks No. Content Remarks

M8000 In RUN,Normally closed M8220
C220 Increase/decrease

counting action

ON:
decrease
action
OFF:
increase
action

M8001 In RUN,Normally open M8221
C221 Increase/decrease

counting action

M8002
After RUN, Output a scan cycle

ON
M8222

C222 Increase/decrease
counting action

M8003
After RUN, Output a scan cycle

OFF
M8223

C223 Increase/decrease
counting action

M8011 Oscillating in 10ms cycle M8224
C224 Increase/decrease

counting action

M8012 Oscillating in 100ms cycle M8225
C225 Increase/decrease

counting action

M8013 Oscillating in 1s cycle M8226
C226 Increase/decrease

counting action

M8014 Oscillating in 1min cycle M8227
C227 Increase/decrease

counting action

M8020 Zero flag M8228
Handwheel function

enablement

M8021 Borrowing flag M8229
C229 Increase/decrease

counting action

M8022 Carry flag M8230
C230 Increase/decrease

counting action

M8024 Specify BMOV direction M8231
C231 Increase/decrease

counting action

ON:
decrease
action
OFF:
increase
action

M8028
During instruction

execution,allow interrupt
M8232

C232 Increase/decrease
counting action

M8029 Instruction execution end flag M8233
C233 Increase/decrease

counting action

M8031 Non-retentive memory is cleared M8234
C234 Increase/decrease

counting action

M8032 Retentive memory is cleared M8235
C235 Increase/decrease

counting action

M8033 Memory retention stop M8236
C236 Increase/decrease

counting action

M8034 Prohibit all output M8237
C237 Increase/decrease

counting action

M8035 Forced RUN mode M8238
C238 Increase/decrease

counting action
M8036 Force RUN command M8239 C239 Increase/decrease
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No. Content Remarks No. Content Remarks
counting action

M8037 Force STOP command M8240
C240 Increase/decrease

counting action

M8045 Prohibit reset of all outputs M8241
C241 Increase/decrease

counting action

M8046 STL state action M8242
C242 Increase/decrease

counting action

ON:
decrease
action
OFF:
increase
action

M8047 STL effective control M8243
C243 Increase/decrease

counting action

M8048 Signal alarm action M8244
C244 Increase/decrease

counting action

M8049 Signal alarm is effective M8245
C245 Increase/decrease

counting action

M8050 Input interrupt (I00 is prohibited) M8246
C246 Increase/decrease

counting action

M8051 Input interrupt (I10 is prohibited) M8247
C247 Increase/decrease

counting action

M8052 Input interrupt (I20 is prohibited) M8248
C248 Increase/decrease

counting action

M8053 Input interrupt (I30 is prohibited) M8249
C249 Increase/decrease

counting action

M8054 Input interrupt (I40 is prohibited) M8250
C250 Increase/decrease

counting action

M8055 Input interrupt (I50 is prohibited) M8251
C251 Increase/decrease

counting action

M8056 Timer interrupt (I6 is prohibited) M8252
C252 Increase/decrease

counting action

M8057 Timer interrupt (I7 is prohibited) M8253
C253 Increase/decrease

counting action

M8058 Timer interrupt (I8 is prohibited) M8254
C254 Increase/decrease

counting action

M8060 I/O Constitute error M8255
C255 Increase/decrease

counting action

M8061 PLC hardware error M8340
The first pulse operation

monitoring

M8062 Serial communication error 0 M8216
C216 Increase/decrease

counting action

M8063 Serial communication error 1 M8217
C217 Increase/decrease

counting action

M8064 Parameter error M8218
C218 Increase/decrease

counting action
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No. Content Remarks No. Content Remarks

M8065 Grammatical error M8219
C219 Increase/decrease

counting action

M8066 Loop error M8341
Y000 clear signal output

function is valid

M8067 Operation error M8342
Y000 specify the origin return

direction
M8068 Operation error latch M8343 Y000 forward limit
M8069 I/O bus detection M8344 Y000 reverse limit

M8075
Sample tracking preparation start

command
M8345

Y000 near-point DOG signal
logic inversion

M8076
Sample tracking execution start

command
M8346

Y000 zero signal logic
inversion

M8077 Sample tracking execution M8347
Y000 interrupt signal logic

inversion

M8078
Sample tracking execution end

control
M8348

Y000 positioning command
driver

M8079 Sampling tracking system area M8349 1st pulse stop
M8120 Can't use M8350 2nd pulse operation monitoring

M8121 RS/RS2 command sends standby

Serial Port 2
refer to chapter
2.11

M8351
Y001 clear signal output

function is valid

M8122 RS/RS2 command to send request M8352
Y001 specify the origin return

direction
M8123 RS/RS2 command reception end M8353 Y001 forward limit

M8124
RS/RS2 command data in

reception
M8354 Y001 reverse limit

M8125
MODBUS and Mitsubishi

function enablement
M8355

Y001 near-point DOG signal
logic inversion

M8128 RD3A/WR3A Receive correct M8356
Y001 zero signal logic

inversion

M8129
RD3A/WR3A communication

timeout
M8357

Y001 interrupt signal logic
inversion

M8160 XCH's SWAP function M8358
Y001 positioning command

driver
M8161 8-bit processing mode M8359 2nd pulse stop
M8170 Input X000 pulse capture M8360 3rd pulse operation monitoring

M8171 Input X001 pulse capture M8361
Y002 clear signal output

function is valid

M8172 Input X002 pulse capture M8362
Y002 specify the origin return

direction
M8173 Input X003 pulse capture M8363 Y002 forward limit
M8174 Input X004 pulse capture M8364 Y002 reverse limit
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No. Content Remarks No. Content Remarks

M8175 Input X005 pulse capture M8365
Y002 near-point DOG signal

logic inversion

M8176 Input X006 pulse capture M8366
Y002 zero signal logic

inversion

M8177 Input X007 pulse capture M8367
Y002 interrupt signal logic

inversion

M8192
Programming port protocol and

other protocol enablement
Serial port3 M8368

Y002 positioning command
driver

M8196
Programming port protocol and

other protocol enablement
Serial port2 M8369 3rd pulse stop

M8198
4 times frequency of C251 and

C252
M8370 4th pulse operation monitoring

M8199 4 times frequency of C253 M8371
Y003 clear signal output

function is valid

M8200
C200 Increase/decrease counting

action

ON: decrease
action
OFF: increase
action

M8372
Y003 specify the origin return

direction

M8201
C201 Increase/decrease counting

action
M8373 Y003 forward limit

M8202
C202 Increase/decrease counting

action
M8374 Y003 forward limit

M8203
C203 Increase/decrease counting

action
M8375

Y003 near-point DOG signal
logic inversion

M8204
C204 Increase/decrease counting

action
M8376

Y003 zero signal logic
inversion

Refer to
chapter 2.9.1

M8205
C205 Increase/decrease counting

action
M8377

Y003 interrupt signal logic
inversion

Serial port 3
Refer to
chapter
2.11.3

M8206
C206 Increase/decrease counting

action
M8378

Y003 positioning command
driver

M8207
C207 Increase/decrease counting

action
M8379 4th pulse stop

M8208
C208 Increase/decrease counting

action
M8396

C254 function corresponds to
input phase

M8209
C209 Increase/decrease counting

action
M8401 RS2 command sends standby

M8210
C210 Increase/decrease counting

action
M8402 RS2 command to send request

M8211
C211 Increase/decrease counting

action
M8403 RS2 command reception end

M8212 C212 Increase/decrease counting M8404 RS2 command data in
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No. Content Remarks No. Content Remarks
action reception

M8213
C213 Increase/decrease counting

action
M8405

RS2 command data setting
ready

M8214
C214 Increase/decrease counting

action
M8408

RD3A/WR3A Receive
Completed

M8215
C215 Increase/decrease counting

action
M8409

RD3A/WR3A
communication timeout

2.4. Special register number and content
NO. Content Remarks NO. Content Num
D8000 Watchdog timer D8184 Z2 Register contents
D8001 PLC type and system version D8185 V2 Register contents

D8002 PLC memory capacity
2...2K steps；
4...4K steps；
8...8K steps；

D8186 Z3 Register contents

D8003 Memory type
10H:Programm

able controller
built-in memory

D8187 V3 Register contents

D8010 Scan current value D8188 Z4 Register contents
D8011 Scan time minimum D8189 V4 Register contents
D8012 Scan time maximum D8190 Z5 Register contents
D8013 Second D8191 V5 Register contents
D8014 Minute D8192 Z6 Register contents
D8015 Hour D8193 V6 Register contents
D8016 Date D8194 Z7 Register contents
D8017 Month D8195 V7 Register contents
D8018 Year D8268 Customize PWM 0~1

division factorD8019 Week D8269

D8020
Input filter adjustment (0-60ms)

initial 10
D8340

1st position pulse amount
Low

D8030 AD0 analog input value D8341 High

D8031 AD1 analog input value D8342
Y0 deviation speed
Initial value:0

D8032 AD2 analog input value D8343
1st pulse maximum speed

Low
D8033 AD3 analog input value D8344 High

D8034 AD4 analog input value D8345
Y0 crawling speed
Initial value: 1000

D8035 AD5 analog input value D8346 Y0 Origin return speed
Initial value:50000

Low
D8036 AD6 analog input value D8347 High
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D8037 AD7 analog input value D8348 1st pulse acceleration time
D8038 AD8 analog input value D8349 1st pulse deceleration time

D8050 DA0 analog output value D8350
2nd position pulse amount

Low

D8051 DA1 analog output value D8351 High

D8058 When DA is current,Bit setting Refer to 5.2 D8352
Y1 deviation speed
Initial value:0

D8059 Constant scan time D8353 2nd pulse maximum speed Low

D8074 X0 Rising edge ring counter
value
[1/6μs unit]

Low D8354 High

D8075 High D8355
Y1 crawling speed
Initial value: 1000

D8076 X0 falling edge ring counter
value
[1/6μs unit]

Low D8356
Y1 Origin return speed

Initial value:50000

Low

D8077 High D8357 High

D8078 X0 pulse width / pulse period
[10μs unit]

Low D8358 2nd pulse acceleration time
D8079 High D8359 2nd pulse deceleration time

D8080 X1 Rising edge ring counter
value
[1/6μs unit]

Low D8360
3rd position pulse amount

Low

D8081 High D8361 High

D8082 X1 falling edge ring counter
value
[1/6μs unit]

Low D8362
Y2 deviation speed
Initial value:0

D8083 High D8363
3rd pulse maximum speed

Low

D8084
X1 pulse width / pulse period
[10μs unit]

Low D8364 High

D8085 High D8365
Y2 crawling speed
Initial value: 1000

D8086 X3 Rising edge ring counter
value
[1/6μs unit]

Low D8366
Y2 Origin return speed

Initial value:50000

Low

D8087 High D8367 High

D8088 X3 falling edge ring counter
value
[1/6μs unit]

Low D8368 3rd pulse acceleration time

D8089 High D8369 3rd pulse deceleration time

D8090 X3 pulse width / pulse period
[10μs unit]

Low D8370
4th position pulse amount

Low

D8091 High D8371 High

D8092 X4 Rising edge ring counter
value
[1/6μs unit]

Low D8372
Y3 deviation speed
Initial value:0

D8093 High D8373
4th pulse maximum speed

Low

D8094 X4 falling edge ring counter
value
[1/6μs unit]

Low D8374 High

D8095 High D8375
Y3 crawling speed
Initial value:1000
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D8096 X4 pulse width / pulse period
[10μs unit]

Low D8376 Y3 Origin return speed
Initial value:50000

Low
D8097 High D8377 High
D8101 PLC type and system version D8378 4th pulse acceleration time
D8102 PLC memory capacity D8379 4th pulse deceleration time

D8108
Number of special modules

connected
D8397

ADPRW command serial port
position

Refer to
chapter 8.2

D8109
Y number of output refresh

error
D8398

0~2147483647(1ms) Ring
count for incremental actions

D8120
Modbus RTU protocol

Communication parameters

Serial port2
Refer to chapter
8.2

D8399

D8121
Master and slave station

number
D8400

Modbus RTU protocol
Communication parameters

D8122
RS command to send data

remaining points
D8401 Communication mode

Serial
port3
Refer to
chapter
8.3

D8123
RS command to receive points

monitoring
D8406 Number of intervals

D8124 RS header <initial value: STX> D8409 overtime time

D8125
RS trailer <initial value:

ETX>
D8410

RS2 header 1, 2 <initial
value: STX>

D8126
Serial port 2 interval period

number
D8411 RS2 header 3, 4

D8127
Specify the starting number of

the communication request of the
lower computer

D8412
RS2 trailer 1, 2 <initial value:

ETX>

D8128
Specify the number of data

requested by the lower computer
communication

D8413
Master and slave station

number

D8129 Set timeout D8414
RS2 receives the summation

calculation result

D8169 Restrict access status D8415
RS2 receives the summation

calculation result
D8182 V1 Register contents D8416 RS2 sends summation
D8183 Z1 Register contents

※Specific functions please refer to "Coolmay PLC instruction

programming manual"

2.5. Function Instructions (Contrast with FX3GS PLC

instruction)

List of basic logic instructions

http://www.coolmay.com/webdown/Coolmay%E5%85%A8%E7%B3%BB%E5%88%97PLC%E6%8C%87%E4%BB%A4%E7%BC%96%E7%A8%8B%E4%BD%BF%E7%94%A8%E6%89%8B%E5%86%8C.pdf
http://www.coolmay.com/webdown/Coolmay%E5%85%A8%E7%B3%BB%E5%88%97PLC%E6%8C%87%E4%BB%A4%E7%BC%96%E7%A8%8B%E4%BD%BF%E7%94%A8%E6%89%8B%E5%86%8C.pdf
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Mnemonic Name Features Available devices
LD take Normally open contact logic operation starts X,Y,M,S,D□.b,T,C
LDI Negate Normally closed contact logic operation starts X,Y,M,S,D□.b,T,C

LDP
Take the rising edge of the

pulse
Start of operation to detect rising edge X,Y,M,S,D□.b,T,C

LDF
Take the falling edge of the

pulse
Start of operation to detect falling edge X,Y,M,S,D□.b,T,C

AND versus Series of normally open contacts X,Y,M,S,D□.b,T,C
ANI With reverse Series of normally closed contacts X,Y,M,S,D□.b,T,C
ANDP With pulse rising edge Detect rising edge series connection X,Y,M,S,D□.b,T,C

ANDF
With the falling edge of the

pulse
Series connection detection of falling edges X,Y,M,S,D□.b,T,C

OR Or pulse rising edge Normally open contacts in parallel X,Y,M,S,D□.b,T,C
ORI Or reverse Normally closed contacts in parallel X,Y,M,S,D□.b,T,C
ORP Or pulse rising edge Parallel connection detecting rising edge X,Y,M,S,D□.b,T,C
ORF Or pulse falling edge Parallel connection to detect falling edge X,Y,M,S,D□.b,T,C
ANB Block with Series connection of circuit blocks -
ORB Block or Parallel connection of circuit blocks -
MPS Push stack Push onto the stack -
MRD Read stack Read stack -
MPP Unstack Pop the stack -
INV Negate Inversion of operation result -
MEP M.E.P Conduction on rising edge -
MEF M..EF Conduction on falling edge -
OUT Output Coil drive Y,M,S,D□.b,T,C
SET Position Movement retention Y,M,S,D□.b

RST Reset Clear action keeps, register cleared
Y,M,S,D□.b,T,C,

D,R,V,Z
PLS pulse Differential output on rising edge Y,M
PLF Falling edge pulse Differential output on falling edge Y,M
MC Master Connection circle command for common series point Y,M
MCR Master reset Instruction to eliminate common series point -
NOP No operation No action -

END End
End of the program and
I/O and return to the beginning

-

Applied instruction can be divided into the following 18 kinds.
1 Data move instructions
2 Data conversion instructions
3 Comparison instructions
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4 Arithmetic operation instructions
5 Logical operation instructions
6 Special function instructions
7 Rotate instructions
8 Shift instruction
9 Data operation instructions
10 Character string operation instructions
11 Program flow control instructions
12 I/O refresh instructions
13 Real time clock control instructions
14 Pulse output/positioning control instructions
15 Serial communication
16 Special block/unit control instructions
17 Extension register/extension file register control instructions
18 Other handy instruct

1. Data move instructions
Mnemonic FNC No. Function Support

MOV 12 Move ★

SMOV 13 Shift Move ★

CML 14 Compliment ★

BMOV 15 Block Move ★

FMOV 16 Fill Move ★

PRUN 81 Parallel Run (Octal Mode) ★

XCH 17 Exchange ★

SWAP 147 Byte Swap ★

EMOV 112 Floating Point Move ★

HCMOV 189 High Speed Counter Move ★

2. Data conversion instructions
Mnemonic FNC No. Function Support

BCD 18
Conversion to Binary Coded

Decimal
★

BIN 19 Conversion to Binary ★

GRY 170 Decimal to Gray Code Conversion ★

GBIN 171 Gray Code to Decimal Conversion ★
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FLT 49 Conversion to Floating Point ★

INT 129 Floating Point to Integer Conversion ★

EBCD 118
Floating Point to Scientific Notation

Conversion
★

EBIN 119
Scientific Notation to Floating Point

Conversion
★

RAD 136
Floating Point Degree to Radian

Conversion
★

DEG 137
Floating Point Radian to degree

Conversion
★

3. Comparison instructions
Mnemonic FNC No. Function Support
LD= 224 Contact compare LD (S1)=(S2) ★

LD> 225 Contact compare LD (S1)>(S2) ★

LD< 226 Contact compare LD (S1)<(S2) ★

LD<> 228 Contact compare LD (S1)≠(S2) ★

LD<= 229 Contact compare LD (S1)≦(S2) ★

LD>= 230 Contact compare LD (S1)≧(S2) ★

AND= 232 Contact compare AND (S1)=(S2) ★

AND> 233 Contact compare AND (S1)>(S2) ★

AND< 234 Contact compare AND (S1)<(S2) ★

AND<> 236 Contact compare AND (S1)≠(S2) ★

AND<= 237 Contact compare AND (S1)≦(S2) ★

AND>= 238 Contact compare AND (S1)≧(S2) ★

OR= 240 Contact compare OR (S1)=(S2) ★

OR> 241 Contact compare OR (S1)>(S2) ★

OR< 242 Contact compare OR (S1)<(S2) ★

OR<> 244 Contact compare OR (S1)≠(S2) ★

OR<= 245 Contact compare OR (S1)≦(S2) ★

OR>= 246 Contact compare OR (S1)≧(S2) ★

CMP 10 Compare ★

ZCP 11 Zone Compare ★

ECMP 110 Floating Point Compare ★

EZCP 111 Floating Point Zone Compare ★

HSCS 53 High speed counter set ★

HSCR 54 High speed counter reset ★

HSZ 55 High Speed Counter Zone Compare ★

HSCT 280 High speed counter table compare ★

BKCMP= 194 Block compare (S1)=(S2) ★
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BKCMP
>

195
Block compare (S1)>(S2) ★

BKCMP
<

196
Block compare (S1)<(S2) ★

BKCMP<
>

197
Block compare (S1)≠(S2) ★

BKCMP<
=

198
Block compare (S1)≦(S2) ★

BKCMP>
=

199
Block compare (S1)≧(S2) ★

4. Arithmetic operation instructions
Mnemonic FNC No. Function Support

ADD 20 Addition ★

SUB 21 Subtraction ★

MUL 22 Multiplication ★

DIV 23 Division ★

EADD 120 Floating Point Addition ★

ESUB 121 Floating Point Subtraction ★

EMUL 122 Floating Point Multiplication ★

EDIV 123 Floating Point Division ★

BK+ 192 Block Data Addition ★

BK- 193 Block Data Subtraction ★

INC 24 Increase ★

DEC 25 Decrement ★

5. Logical operation instructions
Mnemonic FNC No. Function Support
WAND 26 Word AND ★

WOR 27 Word OR ★

WXOR 28 Word Exclusive OR ★

6. Special function instructions
Mnemonic FNC No. Function Support

SQR 48 Square Root ★

ESQR 127 Floating Point Square Root ★

EXP 124 Floating Point Exponent ★

LOGE 125 Floating Point Natural Logarithm ★

LOG10 126 Floating Point Common Logarithm ★
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SIN 130 Floating Point Sine ★

COS 131 Floating Point Cosine ★

TAN 132 Floating Point Tangent ★

ASIN 133 Floating Point Arc Sine ★

ACOS 134 Floating Point Arc Cosine ★

ATAN 135 Floating Point Arc Tangent ★

RND 184 Random Number Generation ★

7. Rotate instructions
Mnemonic FNC No. Function Support

ROR 30 Rotation Right ★

ROL 31 Rotation Left ★

RCR 32 Rotation right With Carry ★

RCL 33 Rotation Left with Carry ★

8. Shift instructions
Mnemonic FNC No. Function Support

SFTR 34 Bit Shift Right ★

SFTL 35 Bit Shift Left ★

SFR 213 Bit Shift Right with Carry ★

SFL 214 Bit Shift Left with Carry ★

WSFR 36 Word Shift Right ★

WSFL 37 Word Shift left ★

SFWR 38 Shift Write [FIFO/FILO Control] ★

SFRD 39 Shift Read [FIFO Control] ★

POP 212 Shift Last Data Read [FILO Control] ★

9. Data operation instructions
Mnemonic FNC No. Function Support
ZRST 40 Zone Reset ★

DECO 41 Decode ★

ENCO 42 Encode ★

MEAN 45 Mean ★

WSUM 140 Sum of Word Data ★

SUM 43 Sum of Active Bits ★

BON 44 Check Specified Bit Status ★

NEG 29 Negation ★

ENEG 128 Floating Point Negation ★

WTOB 141 WORD to BYTE ★

BTOW 142 BYTE to WORD ★
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UNI 143 4-bit Linking of Word Data ★

DIS 144 4-bit Grouping of Word Data ★

CCD 84 Check Code ★

CRC 188 Cyclic Redundancy Check ★

LIMIT 256 Limit Control ★

BAND 257 Dead Band Control ★

ZONE 258 Zone control ★

SCL 259 Scaling (Coordinate by Point Data) ★

SCL2 269 Scaling 2 (Coordinate by X/Y Data) ★

SORT 69 Sort Tabulated Data ★

SORT2 149 Sort Tabulated Data 2 ★

SER 61 Search a Data Stack ★

FDEL 210 Deleting Data from Tables ★

FINS 211 Inserting Data to Tables ★

10. String processing instruction
Mnemonic FNC No. Function Support
ESTR 116 Floating Point to Character String

Conversion
★

EVAL 117 Character String to Floating Point
Conversion

★

STR 200 BIN to Character String Conversion ★

VAL 201 Character String to BIN Conversion ★

DABIN 260 Decimal ASCII to BIN Conversion ★

BINDA 261 BIN to Decimal ASCII Conversion ★

ASCI 82 Hexadecimal to ASCII Conversion ★

HEX 83 ASCII to Hexadecimal Conversion ★

$MOV 209 Character String Transfer ★

$+ 202 Link Character Strings ★

LEN 203 Character String Length Detection ★

RIGH 204 Extracting Character String Data From
the Right

★

LEFT 205 Extracting Character String Data from
the Left

★

MIDR 206 Random Selection of Character Strings ★

MIDW 207 Random Replacement of Character
Strings

★

INSTR 208 Character string search ★

COMRD 182 Read Device Comment Data ★

11. Program flow control instructions
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Mnemonic FNC No. Function Support
CJ 00 Conditional Jump ★

CALL 01 Call Subroutine ★

SRET 02 Subroutine Return ★

IRET 03 Interrupt Return ★

EI 04 Enable Interrupt ★

DI 05 Disable Interrupt ★

FEND 06 Main Routine Program End ★

FOR 08 Start a FOR/NEXT Loop ★

NEXT 09 End a FOR/NEXT Loop ★

12. I/O refresh instructions

Mnemonic
FNC
No.

Function Support

REF 50 Refresh ★

REFF 51 Refresh and Filter Adjust ★

13. Real time clock control instructions
Mnemoni

c
FNC No. Function Support

TCMP 160 RTC Data Compare ★

TZCP 161 RTC Data Zone Compare ★

TADD 162 RTC Data Addition ★

TSUB 163 RTC Data Subtraction ★

TRD 166 Read RTC data ★

TWR 167 Set RTC data ★

HTOS 164 Hour to Second Conversion ★

STOH 165 Second to Hour Conversion ★

14. Pulse output/positioning control instruction
Mnemonic FNC No. Function Support
ABS 155 Absolute Current Value Read ★

DSZR 150 DOG Search Zero Return ★

ZRN 156 Zero Return ★

TBL 152 Batch Data Positioning Mode ★

DVIT 151 Interrupt Positioning ★

DRVI 158 Drive to Increment ★

DRVA 159 Drive to Absolute ★

PLSV 157 Variable Speed Pulse Output ★
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PLSY 57 Pulse Y Output ★

PLSR 59 Acceleration/Deceleration Setup ★

15. Serial communication instructions
Mnemonic FNC No. Function Support
RS 80 Serial Communication ★

R(S2) 87 Serial Communication 2 ★

IVCK 270 Inverter Status Check
IVDR 271 Inverter Drive
IVRD 272 Inverter Parameter Read
IVWR 273 Inverter Parameter Write
IVBWR 274 Inverter Parameter Block Write
IVMC 275 Inverter multiple command
ADPRW 276 MODBUS read and write ★

16. Special block/unit control instructions
Mnemonic FNC No. Function Support
FROM 78 Read From a Special Function Block ★

TO 79 Write To a Special Function Block ★

RD3A 176 Read form Dedicated Analog Block ★

WR3A 177 Write to Dedicated Analog Block ★

RBFM 278 Divided BFM Read
WBFM 279 Divided BFM Write

17. Extension register/extension file register control instructions
Mnemonic FNC No. Function Support
LOADR 290 Load From ER
SAVER 291 Save to ER
RWER 294 Rewrite to ER
INITR 292 Initialize R and ER
INITER 295 Initialize ER
LOGR 293 Logging R and ER

18. Other handy instructions
Mnemonic FNC No. Function Support
WDT 07 Watchdog Timer Refresh ★

ALT 66 Alternate State ★

ANS 46 Timed Annunciator Set ★
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ANR 47 Annunciator Reset ★

HOUR 169 Hour Meter ★

RAMP 67 Ramp Variable Value ★

SPD 56 Speed Detection ★

PWM 58 Pulse Width Modulation ★

DUTY 186 Timing Pulse Generation ★

PID 88 PID Control Loop ★

ZPUSH 102 Batch Store of Index Register ★

ZPOP 103 Batch POP of Index Register ★

TTMR 64 Teaching timer ★

STMR 65 Special timer ★

ABSD 62 Absolute Drum Sequencer ★

INCD 63 Incremental Drum Sequencer ★

ROTC 68 Rotary Table Control ★

IST 60 Initial state ★

MTR 52 Input Matrix ★

TKY 70 Ten Key Input ★

HKY 71 Hexadecimal Input ★

DSW 72 Digital switch (thumbwheel input) ★

SEGD 73 Seven Segment Decoder ★

SEGL 74 Seven Segment With Latch ★

ARWS 75 Arrow Switch ★

ASC 76 ASCII code data input ★

PR 77 Print (ASCII Code) ★

VRRD 85 Volume Read ★

VRSC 86 Volume Scale ★

For detailed instruction usage, please refer to "Coolmay PLC instruction

programming manual"

2.6. Analog input

Input precision of coolmay MX3G HMI PLC All-in-one is 12-bit, directly read

the corresponded register value of each analog while using.

Environment temperature is only used in thermocouple.

2.6.1. Analog input type

Input signal Range
Register
value

Resolution

Accuracy
(Total

Measuring
range)

http://www.coolmay.com/webdown/Coolmay%E5%85%A8%E7%B3%BB%E5%88%97PLC%E6%8C%87%E4%BB%A4%E7%BC%96%E7%A8%8B%E4%BD%BF%E7%94%A8%E6%89%8B%E5%86%8C.pdf
http://www.coolmay.com/webdown/Coolmay%E5%85%A8%E7%B3%BB%E5%88%97PLC%E6%8C%87%E4%BB%A4%E7%BC%96%E7%A8%8B%E4%BD%BF%E7%94%A8%E6%89%8B%E5%86%8C.pdf
http://www.coolmay.com/webdown/Coolmay%E5%85%A8%E7%B3%BB%E5%88%97PLC%E6%8C%87%E4%BB%A4%E7%BC%96%E7%A8%8B%E4%BD%BF%E7%94%A8%E6%89%8B%E5%86%8C.pdf
http://www.coolmay.com/webdown/Coolmay%E5%85%A8%E7%B3%BB%E5%88%97PLC%E6%8C%87%E4%BB%A4%E7%BC%96%E7%A8%8B%E4%BD%BF%E7%94%A8%E6%89%8B%E5%86%8C.pdf
http://www.coolmay.com/webdown/Coolmay%E5%85%A8%E7%B3%BB%E5%88%97PLC%E6%8C%87%E4%BB%A4%E7%BC%96%E7%A8%8B%E4%BD%BF%E7%94%A8%E6%89%8B%E5%86%8C.pdf
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K-type
thermocouple

Room
temperature～

1100℃

Room
temperature～

11000
0.1℃ 1%

K-type
thermocouple
(Negative temp)

-230～1370℃ -2300～13700 0.1℃ 1%

T-type
thermocouple

Room
temperature～

400℃

Room
temperature～

4000
0.1℃ 1%

T-type
thermocouple
(Negative temp)

-230～400℃ -2300～4000 0.1℃ 1%

S-type
thermocouple

Room
temperature～

1690℃

Room
temperature～

16900
0.1℃ 1%

S-type
thermocouple
(Negative temp)

-40～1690℃ -400～16900 0.1℃ 1%

J-type
thermocouple

Room
temperature～

800℃

Room
temperature～

8000
0.1℃ 1%

J-type
thermocouple
(Negative temp)

-90～950℃ -900～9500 0.1℃ 1%

E-type
thermocouple

Room
temperature～

600℃

Room
temperature～

6000
0.1℃ 1%

E-type
thermocouple
(Negative temp)

-110～730℃ -1100～7300 0.1℃ 1%

PT100/PT1000 -200～500℃ -2000～5000 0.1℃ 1%
NTC10K

(The default value
of B is 3435)

-48～110℃ -480～1100 0.1℃ 1%

Voltage 0-10V/0-5V 0～4000 2.5mV/1.25mV 1%
Current Type1 0～20mA 0～4000 5uA 1%
Current Type2 4～20mA 0～4000 4uA 1%

The transmitter which is integrated inside PLC is one of the above table or

mixed ones, it is up to customers’ need when ordering.

2.6.2. Analog input reading

Support FROM instruction or register directly read. Such as: FROM K0 K0
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D400 K8, read out 8 analog input, 0-10V.

The register is directly read: D[8030]~D[8038] is the output value set for the

corresponding type, the constant scan time is changed to D8059, and it is

started by M8039 (version 26232 and above);

NO Register Value
AD0 D8030
AD1 D8031
AD2 D8032
AD3 D8033

AD4(Environ
ment

temperature)

D8034

AD5 D8035
AD6 D8036
AD7 D8037
AD8 D8038

When the analog input has a thermocouple type, it can only do up to 8

channels, of which AD4 is the ambient temperature of the thermocouple.

In the case of 4-20mA type, the register read is less than 3.8mA and the

value is 32760, which is the disconnection value.

2.6.3. Analog input sampling

Filtering cycles=( R23600~R23615)* PLC scanning time, if R23600=1, One

PLC scan cycle sample one time and change the 1st analog input value for

one time. The larger R23600~R23615 value is, the result is more stable.

D8054~D8057 are the first 5 filtering cycles, the default=10;

D8100 is the first 5 channels of smoothing filter coefficient, setting range:

0~999, default=900.

D8455~D8458 are the number of filter cycles of the last 4 channels, the

default = 2 (range 2~20000), the data cannot be less than or equal to 0;

D8450 is the last 4-channel smoothing filter coefficient, setting range: 0~999,

default=100.

2.6.4. Examples of analog input

Below is an example of MX3G 1 channel temperature analog AD0
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acquisition. The program reads the values as follows:

Connect the signal terminal of the temperature sensor to the AD0 input of

the PLC and the other end to the GND of the analog input port.

When the PLC is running, the value of the data register D8030

corresponding to AD0 will be transmitted to D0, the value of D0 will be put into

D10 after floating point operation, and then the floating point number division

operation will be performed on D10, and then operation result will be put into

D20, the result D20 is the actual Temperature value.

In the ladder diagram, you can also directly divide the value of D8030.

Note:When the input is 0-10V analog, the actual analog value = register

reading / 400;

When the input is temperature, the actual temperature value = register

reading/10;

When the input is 0-20mA analog, the actual analog value = register reading

/ 200;

When the input is 4-20 mA analog, the actual analog value = register

reading / 250 + 4.

The analog correction is corrected for the size. The following figure is an

example of correcting the AD0 temperature after acquisition:
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If the current temperature is 37.9℃,the actual test is 47.9 ° C, the error

is 10 ° C, you need to modify the size correction register, show as below:

In the above figure, when M0 is closed, the value -100 is transmitted to the

correction register R23960, and now you can see that the value of the actual

measured temperature D20 is close to the actual temperature which is

37.9 °C.

2.7. Analog output

Analog output range 0~4000, precision is 12 bit. Support TO instruction or

register assignment operation directly.

Adopts TO K0 K0 D500 K2, 2 channels 0~10V or 0~20mA analog output.

Register assignment operation directly: D8050~D8057.

When the default D8058.0~D8058.7=0, it means 0~20mA; when

D8058.0~D8058.7=1, it means 4~20mA.

DA register Range Output type
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Example：

Below shows the 0-10V voltage analog output.

At this point, use a multimeter to check the voltage of the DA0 terminal, that

is, the multimeter's red pen is connected to the DA0 terminal, and the black

pen is connected to the GND terminal. The multimeter is displaying 5V voltage

value.

2.8. PID instruction

1. Outline

This command is used to perform PID control that changes the output value

according to the amount of change in the input.

2. PID instruction format and parameter description

Instruction format:

Parameter Description：

Operand Type Content Data Type
Word software
component

S1.
Save data register number of the

target value (SV)
BIN16 bit D,R

S2.
Save data register number of the

measured value (PV)
BIN16 bit D,R

S3.
Save the data register number of the

parameter
BIN16 bit D,R

D.
Save data register number of the

output register (MV)
BIN16 bit D,R

3. Function and action description

DA0 D8050 0-4000
DA1 D8051 0-4000
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16-bit operation (PID): After setting the target value S1., the measured value

S2., and the parameters S3~S3+6 in the execution program, the operation

result (MV) is saved to the output value D. every sampling time S3. .

Setting item
Setting item Content Occupied points

S1. Target value(SV)
Set target value (SV)

PID instruction does not change the setting
contents

1 point

S2. Measured value(PV) The input value of the PID operation 1 point

S3. Parameter

Auto-tuning: step response method
a)ACT setting：when bit1,bit2,bit5 are

all not "0",occupy 25points Soft
Component starting from the Initial Soft
Component specified in S3.
b)ACT setting：when bit1,bit2,bit5 are

all "0",occupy 20points Soft Component
starting from the Initial Soft Component
specified in S3.

25 points

20 points

D. Output value (MV)

Auto-tuning: step response method
Set the step output value on the user side
before the instruction is driven.
During the auto-tuning process, the MV
output cannot be changed on the side of the
PID instruction.

1 point

Parameter list S3.~S3.+28

Setting item
Setting

content
Remark

S3. Sampling time(Ts) 1~32767(ms)
Value shorter than the

calculation period can’t be run
S3.

+1
ACT bit0

0: positive
action;

Action direction (ACT)
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1: reverse
action.

bit1

0: No input
change alarm;
1: Input

change amount
alarm is valid.

bit2

0: No output
change alarm;
1: Output

change amount
alarm is valid.

Do not turn ON bit2 and bit5
at the same time

bit3 Can't use

bit4

0:
Auto-tuning
doesn’t work;
1: Perform

auto-tuning.

bit5

0: No output
value upper and
lower limit
setting;
1: The output

value upper and
lower limits are
valid.

Do not turn ON bit2 and bit5
at the same time

bit6
0: Step

response
method.

Auto-tuning mode

bit7~bit15 Can't use
S3.

+2
Input filter constant (α) 0~99(%) 0 means no input filtering

S3.
+3

Proportional gain () 1~32767(%)

S3.
+4

Integration time()
0~32767(*10

0ms)
0 means as ∞ processing (no

points)
S3.

+5
Differential gain () 0~100(%) 0 means no derivative gain

S3.
+6

Derivative time ()
0~32767(*10

ms)
0 means no differential

processing
S3.

+7
...

PID operation internal processing occupied, please do not change the data.
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S3.+1
9

S3.
+20*1

Input change amount (increase
side) alarm set value

0~32767
(ACT):

Valid when S3.+1 bit1=1
S3.

+21*1
Input change amount (decrease

side) alarm set value
0~32767

(ACT):
Valid when S3.+1 bit1=1

S3.
+22*1

Output change amount (increase
side) alarm set value

0~32767
(ACT):
Valid when S3.+1 bit2=1，

bit5=0

Output upper limit set value
-32768~3276

7

(ACT):
Valid when S3.+1 bit2=0，

bit5=1

S3.
+23*1

Output change amount
(decrease side) alarm set value

0~32767
(ACT):
Valid when S3.+1 bit2=1，

bit5=0

Output lower limit set value
-32768~3276

7

(ACT):
Valid when S3.+1 bit2=0，

bit5=1

S3.
+24*1

Alarm output

bit0

0: The input
change amount
(increase side)
does not
overflow;
1: Input

change amount
(increase side)
overflow.

(ACT):
Valid when S3.+1 bit1=1 or

bit2=1

bit1

0: The input
change amount
(reduction side)
does not
overflow;
1: Input

change amount
(reduction side)
overflow.

bit2

0: The output
change amount
(increase side)
does not
overflow;
1: Output
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change amount
(increase side)
overflow.

bit3

0: The output
change amount
(reduction side)
does not
overflow;
1: Output

change amount
(reduction side)
overflow.

*1: When S3+1 action setting (ACT) bit1=1, bit2=1 or bit5=1, S3+20~24 is occupied.

4. Notice

When using multiple instructions： It can be executed multiple times at

the same time (the number of loops is not limited), but note that the S3 and D

devices used in the operation cannot be repeated.

Occupied points of parameter S3. : Step response method

1) ACT setting：when bit1,bit2,bit5 are all not "0",occupy 25points Soft

Component starting from the Initial Soft Component specified in S3.

2) ACT setting：when bit1,bit2,bit5 are all "0",occupy 20points Soft

Component starting from the Initial Soft Component specified in S3.

Step response mode: The self-tuning mode in the PID instruction has
only a step response mode, and the step value is S0+22, which is the upper
limit value.

When specifying the soft component in the power failure holding
area：If D. is specified in the program to hold the data register in the power
failure, needs to clear the specified register at the time of program start up.

Action flag: bit 0=0 of S3+1 is a positive action, and bit0=1 is a reverse
action; When heating, is reverse action.

5. Example
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2.9. Application of high speed counter

2.9.1. Assignment table of built-in high speed counter

MX3G PLC high-speed counting conventional 2 single-phase 60KHz + 4

10KHz or 1 AB (Z) phase 30KHz +1 AB (Z) phase 5KHz; among them,

dual-phase double counting input, the default is 1 frequency.
Counter type

No.
Input assignment

Single phase
single counter
input

X000 X001 X002 X003 X004 X005
C235 U/D
C236 U/D
C237 U/D
C238 U/D

D80
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C239 U/D
C240 U/D
C241 U/D R
C242 U/D R
C243 U/D R
C244 U/D R
C245 U/D R

Single phase
double counter
input

C246 U D
C247 U D R
C248 U D R
C249 U D R
C250 U D R

AB phase
double counter
input

C251 A B
C252 A B R
C253 A B R

U: up counter D: down counter A: A phase input

B: B phase input R: External reset input

Single phase: up to 6 channels, maximum frequency 2 channels 60KHz+4

channels 10KHz

AB phase:

1 times frequency: 1 channel AB (Z) phase 30KHz +1 channel AB (Z)

phase 5KHz;

4 times frequency:4 times frequency: up to 2 channels, the maximum

frequency is 10KHz;

M8198 is the 4 times frequency logo of C251;

M8199 is the 4 times frequency logo of C253.

2.9.2. Related device

1. For switching up/down counting of Single phase single counter

Type
Counter
number

Designated
device

Up
counting

Down
counting

Single phase single
counter input

C235 M8235

OFF ON

C236 M8236
C237 M8237
C238 M8238
C239 M8239
C240 M8240
C241 M8241
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C242 M8242
C243 M8243
C244 M8244
C245 M8245

2. For monitoring the up/down counting direction of Single phase

double counter and AB phase double counter

Type
Counter

number
Designated

device
Up

counting
Down

counting

Single phase
double counter
input

C246 M8246

OFF ON

C247 M8247
C248 M8248
C249 M8249
C250 M8250

AB phase
double counter
input

C251 M8251
C252 M8252
C253 M8253

3. For High-speed counter function switching
Device
name

Name Content

M8198 Function switching
device

1 times/4 times switching device for
C251/C252

M8199 1 times/4 times switching device for C253

2.10. Application of high speed pulse

2.10.1. High speed pulse output

Coolmay 3G PLC high-speed pulse output conventional 4 channels, 70C:

Y0-Y1 is 100KHz, Y2-Y3 is 50KHz; 43C: Y0-Y1 is 100KHz, Y2-Y3 is 10KHz.

Support variable speed, the initial/final speed of start/stop is 0, the chart is as

follows: (take acceleration and deceleration time D8348 as an example).
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Acceleration/deceleration time T calculation= (target speed-current speed) *

acceleration/deceleration time/maximum speed.

For example, target speed = 50000, current speed = 20000, acceleration

time 100 (ms), maximum speed = 100,000, T = 30 ms.

PLSY, ZRN, PLSV, DRVI, DRVA, DVIT, DSZR, only Y0-Y3 supports DVIT

(interrupt positioning), DSZR (origin return with DOG search) instructions.
Pulse point

Function
Description

Y0 Y1 Y2 Y3

Pulse operation
monitoring

M8340 M8350 M8360 M8370

Position pulse
（32bit）

D8340
D8341

D8350
D8351

D8360
D8361

D8370
D8371

accelerate /
decelerate

time

D8348、
D8349

D8358、
D8359

D8368、
D8369

D8378、
D8379

Pulse stop bit M8349 M8359 M8369 M8379

Maximum speed
D8343
D8344

D8353
D8354

D8363
D8364

D8373
D8374

The original FX3G pulse program can be used directly.

2.10.2. Pulse width modulation (PWM)

1. Outline

This instruction is used to specify the pulse period and pulse output of the

ON time.

2. PWM instruction format and parameter description.

Instruction format：

Parameter description：
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Operand
type

Content
Data
type

Word software
component

Range

S1.
Word soft component numbers of

Pulse width (ms) data or saving data
BIN

16 bit
KnX, KnY, KnM, KnS,
T, C, D, R, V, Z, K, H

0~32767ms

S2.
Word soft component numbers
of Period (ms) data or saving data

BIN
16 bit

KnX, KnY, KnM, KnS,
T, C, D, R, V, Z, K,H

1~32767ms

D.
Soft component (Y) numbers
of Output pulse

BIN
16 bit

Y
Y0-Y3(5~100KHz)
Y4-Y7(5~10KHz)

3. Function and action description

16-bit operation (PWM):Pulse output in units of period [S2.ms],Its ON pulse

width is [S1.ms].

Notes:

Value of the pulse width S1. and the period S2. should be set: S1.≦S2.。

When instruction input is OFF, Output from D. is also OFF.

Do not operate the setting switch of the pulse output mode during pulse

emission.

4. Program Example

In this example, the data range of D10 is changed from 0 to 50, and the

average output of Y0 is 0 to 100%. If D10 data >50, it will be wrong.

Example for smooth loop
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R >> P

t = R(KΩ)* C(µF) = 470ms >>T0

Compared to the pulse period T0,the time constant τ of the filter is a very

large value.

The fluctuation value Δe of average output current e is approximately

5. Special Note

Conventional PWM

1) Support a total of 4 channels Y0-Y3 (please select transistor MT output);

2)There is no limit to the pulse width and pulse period, both in milliseconds

(ms).

2.11. PLC Communication port instructions

PLC defaulted has a RS232 programming port, and two communication

ports ( Rs232 or Rs485) can be added. Meanwhile, CANbus is also

optional.

2.11.1. MODBUS instruction interpretation and communication address

PLC, when as master, support ADPRW command,RD3A

command,WR3A command,this section will give you detailed description

about these commands.

2.11.1.1. RD3A/WR3A command function and action description:

Read slave data (RD3A)：
For CoolMay PLC, the RD3A instruction corresponds to Modbus's No. 03

function.

m1 represents the station number of the read slave device,range:1-247;

m2 represents the first address number of the read data in the slave device;

D represents the number of registers read, range: 1-125(When Modbus
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ASCII,range is1-45; When CAN communication,range is 1-90), and the read

data is sequentially stored in the host D.+1, D.+2.

D-1 address value must be set to (=0: serial port 2; =1: serial port 3)

Write data to the slave (WR3A):

For CoolMay PLC, the WR3A instruction corresponds to Modbus's 06 and

10 functions.

m1 represents the station number of the slave device to be written,

range :1-247.

m2 represents the first address number of the write register in the slave

device;

S represents the numbers of registers to be written, ranging:1-123(When

Modbus ASCII,range is1-45; When CAN communication,range is 1-90). The

data to be written is sequentially stored in the host S.+1, S.+2.

S=1, the WR3A instruction corresponds to the Modbus 06 function.

S=2-123, the WR3A instruction corresponds to the Modbus 10 function.

S.-1 address value must be set to (=0: serial port 2; =1: serial port 3)

RD3A and WR3A only support the below MODBUS functions:

Function No. 03: Read holding register and takes the current binary value

range of 1-125 in one or more holding registers.

Function No. 06: Load the specific binary value into a holding register (write

register) ,range:1.

Function No. 10: Preset multiple registers, load specific binary values into a

series of consecutive holding registers (write multiple registers),range:1-123.

2.11.1.2. ADPRW command function and action description:

ADPRW instruction supports all functions of the MODBUS RTU.

No. 01: Read coil status and get the current status (ON/OFF) of a group of
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logic coils, range 1-512

No. 02: Read the input status and get the current status (ON/OFF) of a

group of switch inputs, range 1-512

No. 03: Read the retentive register and get the current binary value in one or

more retentive registers, ranging from 1-125

No. 04: Get the current binary value in one or more input registers, range

1-125

No. 05: Force a single coil to force the on/off state (write bit) of a logic coil,

range 1

No. 06: Load specific binary values into a retentive register (write register),

range 1

No. 0F: Force multiple coils, forcibly open and close a series of continuous

logic coils (write multiple bits), range 1-1968

No. 10: Preset multiple registers, load specific binary values into a series of

consecutive holding registers (write multiple registers). Range 1-125

ADPRW ：

S. indicates the station number of the slave device to be read and written,

the range is 0-247;

S1. indicates the function code (that is, the functions NO 01-06, 15, and 16 );

S2. The function parameter corresponding to each function code (the

operand indicates the MODBUS start address when the function is 01);

S3. The function parameters corresponding to each function code (the

operand indicates the number of access points when the function is 01, and

the parameter is fixed to 0 when the 05 function is used);

D. indicates the starting position of the data storage device.
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2.11.1.3. Word device communication address number

MODBUS device
CX3G/FX3GC deviceInput register (readout

dedicated)
Holding register (read/write)

- 0x0000～0x1F3F D0～D7999
- 0x1F40～0x213F D8000～D8511
- 0x2140～0x7EFF R0～R23999
- 0x7F00～0xA13F Unused address
- 0xA140～0xA27F TN0～TN319
- 0xA280～0xA33F Unused address
- 0xA340～0xA407 CN0～CN199
- 0xA408～0xA477 CN200～CN255
- 0xA478～0xA657 M0～M7679
- 0xA658～0xA677 M8000～M8511
- 0xA678～0xA777 S0～S4095
- 0xA778～0xA78B TS0～TS319
- 0xA78C～0xA797 Unused address
- 0xA798～0xA7A7 CS0～CS255
- 0xA7A8～0xA7AF Y0～Y177
0xA7B0～0xA7B7 - Unused address
0xA7B8～0xA7BF - X0～X177
An error occurs when accessing an unused address

CN200～255 is a 32-bit counter

2.11.1.4. Bit device Communication address number

MODBUS device
MX3G deviceInput (readout

dedicated)
Coil (read/write)

- 0x0000～0x1DFF M0～M7679
- 0x1E00～0x1FFF M8000～M8511
- 0x2000～0x2FFF S0～S4095
- 0x3000～0x313F TS0～TS319
- 0x3140～0x31FF Unused address
- 0x3200～0x32FF CS0～CS255
- 0x3300～0x337F Y0～Y177
0x3380～0x33FF - Unused address
0x3400～0x347F - X0～X177
An error occurs when accessing an unused address
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2.11.1.5. ADPRW Command function parameter

Operand function
S1.

Function
code

S2.
MODBUS

address/subfunction code

S3.
Access

points/subfunction data

D.
Data storage device start

Coil readout 1H
MODBUS Address：
0000H~FFFFH

Access points：
1~2000

Read object device
D.R.M.Y.S

Input readout 2H
MODBUS Address：
0000H~FFFFH

Access points：
1~2000

Read object device
D.R.M.Y.S

Holding register
readout

3H
MODBUS Address：
0000H~FFFFH

Access points：1~125
Read object device

D.R
Input register

readout
4H

MODBUS Address：
0000H~FFFFH

Access points：1~125
Read object device

D.R

Single coil write 5H
MODBUS Address：
0000H~FFFFH

0(Fix)

Write object device
D.R.X.Y.M.S
0=OFF
1=ON

Single register
write

6H
MODBUS Address：
0000H~FFFFH

0(Fix)
Write object device

D.R

Bulk coil writing FH
MODBUS Address：
0000H~FFFFH

Access points：
1~1968

Write object device
D.R.X.Y.M.S

Bulk register write 10H
MODBUS Address：
0000H~FFFFH

Access points：1~123
Write object device

D.R
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2.11.2. Serial port 2: RS485(A B)

Support MITSUBISHI programming port protocol,Mitsubishi BD board

protocol,Free port protocol and MODBUS RTU protocol;

The special relays and registers related to this serial port are as below:

Functions
Serial port
2(A/B)

Serial port
3(A1/B1)

Remark

Mitsubishi programming port
protocol

M8196=0 M8192=0
power lost can not be

retentive

Freeport protocol function
M8196=1
M8125=0

M8192=1

RS/RS2 sending mark M8122=1 M8402=1

RS/RS2 sending completion mark - -
Need to reset
manually

RS/RS2 receiving completion mark M8123 M8403
Need to reset
manually

RS/RS2 receiving process mark M8124 M8404 Data is receiving
RS/RS2 command 8/16 bits
differentiation mark

M8161 M8161

RS2 command end operation settings - 1

MODBUS function
M8196=1
M8125=1

M8192=1

RD3A/WR3A Receive correct
mark

M8128 M8408 Automatic reset

RD3A\WR3A communication
over-time mark

M8129 M8409 Automatic reset

ADPRW command completion mark M8029 M8029
Command execution

end mark
Communication parameters D8120 D8400
Communication mode - D8401

Master-slave station number D8121 D8414

RD3A/WR3A overtime D8129 D8409
Unit: ms (detailed
setting,refer to
explanation)

RD3A/WR3A interval period D8126 D8406
RD3A\WR3A end operation -1 0 1

ADPRW command settings D8397=0 D8397=1

M8196: the activation flag of using programming port protocol and other



COOLMAY MX3G PLC HMI All in one Programming manual

47

protocol .

M8125: the activation flag of using MODBUS and the original Mitsubishi

function.

M8122: RS sending flag (this bit needs to be set 1 when using the RS

instruction, and it will automatically reset after sending).

M8123: RS receiving completion flag, need to reset manually.

M8124: RS command data is being received.

M8161: 8-bit/16-bit mode flag of RS instruction

M8128: RD3A / WR3A receive the correct flag.

M8129:RD3A/WR3A communication over-time flag. (when communication

is over-time, flag is ON)

M8029: Communication completion flag (communication completion flag

when using ADPRW instruction, need to reset manually).

D8120: Save the communication parameters of Modbus RTU protocol, see

the figure below for specific settings.D8121: Save the host or slave station

number.

D8129: RD3A and WR3A timeout period. (The unit is milliseconds, it is

recommended to set: when the communication rate setting is greater than or

equal to 9600, D8129 is set to 10~20; when the communication rate setting is

less than 9600, D8129 is set to 20~50)

D8126: Interval period. Default as 10 times.

D8397: When using the serial port 2 in the ADPRW instruction, set D8397 to

0.

Support RS, WR3A, RD3A, ADPRW instructions. Can be set in the

parameter zone, corresponding to serial port 2. The parameter zone

settings are only valid for this channel. It is invalid for serial port 3.

2.11.2.1. Mitsubishi programming port protocol

When used as programming port protocol: set M8196=0.
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2.11.2.2. Free port protocol function and example

When used as Mitsubishi free port protocol: set M8196=1，M8125=0;

the difference between Mitsubishi protocol 1 and protocol 4 is with end mark

OA OD ( stored in D8124, D8125 separately)

For Mitsubishi Freeport Protocol, RS instruction is supported, the D8120

only needs to set the value of the lower 8 bits.

b0 Data length 0:7 bits 1:8bits
b1
b2

Odd and Even (b2,b1)
00: None 01: Odd 02: Even

b3 Stop bit
0: 1 bit
1: 2 bits

b4
b5
b6
b7

BPS rate (b7,b6,b5,b4)
(0100):600bps (0101):1200bps (0110):2400bps
(0111):4800bps (1000):9600bps (1001):19200bps
(1010):38400bps (1011):57600bps (1101):115200bps

Demo program：

Use the serial port tool by serial port 2 to monitor the data obtained is

[2019:11:01:10:49:16][receive]31 32 33
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2.11.2.3. Modbus RTU Protocol

When used as MOdbus RTU： set M8196=1,M8125=1; set D8120 as

communication parameters, D8121 sets the station number of the slave. For

example: D8120=HE081,D8121=H1(communications parameter as

9600/8/n/1,station number is 1)

D8120 Parameter set

b0
Data length
0:7 bit
1:8 bit

b1
b2

Parity (b2,b1)
00:None 01:Odd 11:Even

b3 Stop bit 0:1 bit 1:2 bit
b4
b5
b6
b7

Baud rate (b7 b6 b5 b4)
0100:600bps 0101:1200bps 0110:2400bps
0111:4800bps 1000:9600bps 1001:19200bps
1010:38400bps 1011:57600bps 1100:115200bps

b8

Set 0
b9
b10
b11
b12 RTU/ASCII Mode Selection 0:RTU 1:ASCII
b13 Set 1
b14 Set 1
b15 Set 1

RD3A Program example (refer to 2.11.1.1):

Slave program:
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Master program:

Program explanation:

D300 saves the numbers of registers read, which means that 10 data is

read.

When using serial port 2, D.-1, here D299 must be set to 0.

This program represents that 10 data of the registers D100-D109 in the PLC

with the slave station 1 are read and stored in the registers D301-D310 of the

master station PLC.
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WR3A Program example (refer to 2.11.1.1):

Master program:

Slave program:

Program explanation:

This program represents that 1 data of the register D301 in the master PLC

is written to the PLC in Slave 1, and is stored in the register D100 of the slave

PLC.
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2.11.2.4. MODBUS RTU ADPRW command

03 function code hold register output. (refer to 2.11.1.2):

Master program:

Slave program:
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Use the serial port tool to monitor serial port 2 for below data:

[2017:11:01:17:48:54][receive]01 03 00 00 00 06 C5 C8

[2017:11:01:17:48:54][receive]01 03 0C 00 0C 00 17 00 22 00 38 00 4E 00

63 C4 29

2.11.2.5. Modbus ASCII Protocol

When used as Modbus ASCII protocol,specific parameter setting pls refer

2.11.2.3,Only the 12th bit of D8120 is set differently,checking D8120

parameter setting in section 2.11.2.3.

Note: In modbus ASCII protocol, ADPRW command is not supported.

Program example

Master program：

Slave program：
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Data of the Master D300~D303 before and after the program execution is

showed as below.

2.11.3. Serial port 3:RS485 (A1 B1)/RS232

Support Mitsubishi programming port protocol,RS2 protocol and MODBUS

protocol.

The special relays and registers related to this serial port are as below.

Functions
Serial port
2(A/B)

Serial port
3(A1/B1)

Remark

Mitsubishi programming
port

M8196=0 M8192=0
26232 or higher version:

power lost can not be
retentive

Freeport protocol function
M8196=1
M8125=0

M8192=1

RS/RS2 sending mark M8122=1 M8402=1
RS/RS2 sending

completion mark
- - Need to reset manually
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RS/RS2 receiving completion
mark

M8123 M8403 Need to reset manually

RS/RS2 receiving process
mark

M8124 M8404 Data is receiving

RS/RS2 command 8/16 bits
differentiation mark

M8161 M8161

RS2 command end operation
settings

- 1

MODBUS function
M8196=1
M8125=1

M8192=1

RD3A/WR3A Receive
correct mark

M8128 M8408 Automatic reset

RD3A\WR3A communication
over-time mark

M8129 M8409 Automatic reset

ADPRW command
completion mark

M8029 M8029
Command execution end

mark
Communication parameters D8120 D8400
Communication mode - D8401

Master-slave station
number

D8121 D8414

D8434:CAN slave station
Number
D8440\D8442 multi-device

mode ID Number

RD3A/WR3A overtime D8129 D8409
Unit: ms (detailed

setting,refer to explanation)
RD3A/WR3A interval

period
D8126 D8406 26232 or higher version

RD3A/WR3A end operation
-1

0 1

ADPRW command settings D8397=0 D8397=1 26232 or higher version

M8192：the activation flag of using programming port protocol and other

protocol

M8402：Send flag (use when RS2 instruction)。

M8403：Communication completion flag (communication completion flag

when using RS instruction, needs to be reset by hand).

M8404: Data is receiving.

M8408：Communication completion mark (Valid while using ADPRW

command and needs manual reset).

M8409: Communication time out.
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M8029: Communication completion mark (communication completion mark

while using ADPRW instruction and needs manual reset).

M8161: 8-bit/16-bit mode distinguishing mark for RS/RS2 command.

D8400: Save the communication parameters of the Modbus RTU protocol

D8401:Save the communication mode of serial port 3.

D8401=H0 represents the RS2 free communication mode.

When Modbus RTU：D8401=H11 represents PLC as Slave. D8401=H1

represents PLC as Master.

When Modbus ASCII：D8401=H111represents PLC as Slave；

D8401=H101represents PLC as Master.

D8406: Interval period. Default as 12 times.

D8409: overtime time. (The unit is milliseconds, it is recommended to set:

when the communication rate is greater than or equal to 9600, D8409 is set to

10~20; when the communication rate is set to less than 9600, D8409 is set to

20~50;)

D8414: Save the master or slave station number (The value mast be set as

max K255 as master).

D8126: When using the serial port 3 in the ADPRW instruction, set D8126 to

1.

D8397: When using the serial port 3 in the ADPRW instruction, set D8397 to

1.

Support RS2,WR3A,RD3A,ADPRW instructions,Can be set in parameter

zone，correspond to serial port 3. Parameter zone settings are valid only for

this channel. Invalid for serial port 2.

D8400 Parameter set
b0 Data length 0:7 bit 1:8 bit

b1
b2

Parity (b2,b1)
00:None 01:Odd 11:Even

b3 Stop bit 0:1 bit 1:2 bit
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b4
b5
b6
b7

Baud rate (b7 b6 b5 b4)
0100:600bps 0101:1200bps 0110:2400bps
0111:4800bps 1000:9600bps 1001:19200bps

b8~b15 Unavailable, Set 0

D8401 Parameter set

b0
Select protocol
0: Other communication protocol
1: MODBUS protocol

b1~b3 Unavailable, Set 0

b4
Master/Slave setting
0: MODBUS Master 1: MODBUS Slave

b5~b7 Unavailable, Set 0

b8 RTU/ASCII Mode selection 0:RTU 1:ASCII

b9~b15 Unavailable, Set 0

2.11.3.1. Mitsubishi programming protocol

When using as mitsubishi programming port protocol: set M8192=0.

2.11.3.2. Free port protocol

When using as mitsubishi free port protocol: set M8192=1, M8402=1;

Program example:
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Use the serial port tool to monitor serial port 3 for data:

[2017:11:01:11:49:16][receive]31 32 33

Last parameter of RS2 instruction =1: Serial port 3.

2.11.3.3. Modbus RTU protocol RD3A/WR3A command

Used as MOdbus RTU： set M8192=1; set D8400 as communication

parameters, set D8414 s as master slave station no.

For example: D8400=H81，D414=K1（communications parameter as

9600/8/n/1,slave station number is 1）

RD3A Program Example (Refer to 2.11.1.1):

Master program：

Slave program：
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Use the serial port tool to monitor serial port 3 for below data:

[2017:11:01:09:00:11][receive]01 03 00 64 00 0A 84 12

[2017:11:01:09:00:11][receive]01 03 14 00 42 00 4D 00 58 00 58 00 63 00

37 00 2C 00 21 00 16 00 0B 9F C7

WR3A Program Example (Refer to 2.11.1.1):

Master program
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Slave program

Use the serial port tool to monitor serial port 3 for below data:

[2017:11:01:09:25:20][receive]01 10 00 64 00 08 10 00 0B 00 16 00 21 00

2C 00 37 00 42 00 4D 00 58 D1 6C

[2017:11:01:09:25:20][receive]01 10 00 64 00 08 10 00 0B 00 16 00 21 00

2C 00 37 00 42 00 4D 00 58 D1 6C

2.11.3.4. MODBUS RTU ADPRW Command

04 register input readout. Program Example (Refer to 2.11.1.2):

Master program
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Slave program

Use the serial port tool to monitor serial port 3 for below data:

[2017:11:01:17:38:34][receive]01 04 00 00 00 06 70 08

[2017:11:01:17:38:34][receive]01 04 0C 00 15 00 20 00 2B 00 41 00 57 00

00 5F A7

2.11.3.5. Modbus ASCII Function

When used as Modbus ASCII protocol,specific parameter setting please

refer to 2.11.3,Only the 8th bit of D8401 is set differently,checking D8120

parameter setting in section 2.11.3.

Note: In modbus ASCII protocol, ADPRW command is not supported.

Program example

Master program：
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Slave program：

Data of the Slave D100~D109 before and after the program execution is

showed as below:
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2.11.4. Network N:N communication

2.11.4.1. Related device content

1. N:N network setting device
Soft

element
name content

Set
value

M8038 Parameter setting

Set the flag for communication parameters.
It can also be used as a flag to confirm the presence of
N:N network programs.
Do not turn ON in the sequence program.

D8176
Corresponding
station number
setting

N:N network setting station number when using.The
master station is set to 0, and the slave station is set to 1
to 15. [Initial value: 0]

0~15

D8177
Slave total number
setting

Set the total number of slave stations.
No setting is required in the PLC of the slave station.
[Initial value: 7]

1~15

D8178
Refresh
Range setting

Select the mode of the number of device points to
communicate with each other.
No setting is required in the PLC of the slave station.
[Initial value: 0]

0~2
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D8394
Serial channel
selection

=2：Serial port 2
=3：Serial port 3

2~3

2. Components for judging N:N network errors

M8184~M8190, M8496~M8503: The data transmission sequence error flag

of the slave station.

When a data transmission sequence error occurs in each slave station, the

corresponding flag bit turns ON.
Station
No.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Relay
M

8184
M

8185
M

8186
M

8187
M

8188
M

8189
M

8190
M

8496
M

8497
M

8498
M

8499
M

8500
M

8501
M

8502
M

8503

3. Link device

It is a device for sending and receiving information between programmable

controllers. The device number and the number of points used differ

depending on the station number set in the corresponding station number

setting and the mode set in the refresh range setting.

1) Mode 0 (D8178=0):

Station No
Station

0
Station

1
Station

2
Station

3
Station

4
Station

5
Station

6
Station

7
Word device (4
points each)

D0~D3
D10~
D13

D20~
D23

D30~
D33

D40~
D43

D50~
D53

D60~
D63

D70~
D73

Station No
Station

8
Station

9
Station
10

Station
11

Station
12

Station
13

Station
14

Station
15

Word device (4
points each)

D80~
D83

D90~
D93

D100~
D103

D110~
D113

D120~
D123

D130~
D133

D140~
D143

D150~
D153

2) Mode 1 (D8178=1):

Station No
Station

0
Station

1
Station

2
Station

3
Station

4
Station

5
Station

6
Station

7

Bit device (32
points each)

M1000~
M1031

M1064~
M1095

M1128~
M1159

M1192~
M1223

M1256~
M1287

M1320~
M1351

M1384~
M1415

M1448~
M1479

Word device
(4 points each)

D0~D3
D10~
D13

D20~
D23

D30~
D33

D40~
D43

D50~
D53

D60~
D63

D70~
D73
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Station No
Station

8
Station

9
Station
10

Station
11

Station
12

Station
13

Station
14

Station
15

Bit device (32
points each)

M1512~
M1543

M1576~
M1607

M1640~
M1671

M1704~
M1735

M1768~
M1799

M1832~
M1863

M1896~
M1927

M1960~
M1991

Word device
(4 points
each)）

D80~
D83

D90~
D93

D100~
D103

D110~
D113

D120~
D123

D130~
D133

D140~
D143

D150~
D153

3) Mode 2 (D8178=2):

Station No
Station

0
Station

1
Station

2
Station

3
Station

4
Station

5
Station

6
Station

7

Bit device
(64 points
each)

M1000~
M1063

M1064~
M1127

M1128~
M1191

M1192~
M1255

M1256~
M1319

M1320~
M1383

M1384~
M1447

M1448~
M1511

Word device
(8 points
each)

D0~D7
D10~
D17

D20~
D27

D30~
D37

D40~
D47

D50~
D57

D60~
D67

D70~
D77

Station No
Station

8
Station

9
Station
10

Station
11

Station
12

Station
13

Station
14

Station
15

Bit device
(64 points
each)

M1512~
M1575

M1576~
M1639

M1640~
M1703

M1704~
M1767

M1768~
M1831

M1832~
M1895

M1896~
M1959

M1960~
M2023

Word device
(8 points
each)

D80~
D87

D90~
D97

D100~
D107

D110~
D117

D120~
D127

D130~
D137

D140~
D147

D150~
D157

2.11.4.2. Program setting and description

The program settings are as shown below. It is recommended to set the

timeout wait register D8129/D8409/D8429 above 12. It is only necessary to set

the corresponding special register to achieve the data sharing of the

corresponding interval register and auxiliary relay. Channel M8184~M8190

and the rear 8 channels M8496~M8503, you can check the status of each

slave, if there is no connection, turn ON

1. Serial port 2
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Master program:

Slave program:

2. Serial port 3

Such as serial port 2, only need the master and slave program to set

D8394=3



COOLMAY MX3G PLC HMI All in one Programming manual

67

3. HMI

3.1. How to install TPWorks software

(Please go to the official website :WWW.COOLMAY.COM to download the

latest version)

This chapter will detaily introduce the installation process of TPWorks

software.

Hardware requirements

The basic hardware requirements for installing TPWorks editing software

are as follows:

1. Personal computer host: It is recommended to use a CPU of 80486 or

higher.

2. Memory: It is recommended to use more than 128MB RAM to expand the

memory.

3. Hard disk: The hard disk must have more than 100MB of space.

4. Display: General VGA or SVGA display card.

5. Mouse: Use a Windows compatible mouse.

6. Printer: Use a Windows compatible printer.

Before you install it, please check whether the computer hardware is as

above or higher. In order to avoid problems with hardware incompatibility,

please use the recommended specifications as much as possible. If you have

any questions, please contact our customer service.

Software source

You can enter our company's website WWW.COOLMAY.COM to obtain the

latest version of the software.

Installation steps (take the simplified Chinese version of TPWorks as an

example), note that "TPWorks ***" software version is subject to the official

website.

Select TPWorks 13802.exe in the installer window to start the installer and

start the installation;

http://www.coolmay.com
http://www.coolmay.com
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Set the storage path of the installation file, select the default, or enter

the address, or click the [Browse ...] button to select the address, and then

click the [Next] button;

Set the name of the saved folder. It is recommended to select the

default and click the [Next] button directly.
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Choose whether to create a desktop shortcut icon, and then click the

[Next] button.

Confirm the installation path and other installation information, and

then click the [Install] button to install.
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The installation process is shown below:

Click [Next] to install the driver wizard

The driver installation is completed



COOLMAY MX3G PLC HMI All in one Programming manual

71

Finally, click [Finish] to complete the installation.

3.2. How to open the TPWorks software

After the installation of TPWorks software is completed, a shortcut will be
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placed on the desktop . At the same time, the corresponding mView

program group has been added to the Windows start menu:

Choose either of the above two methods to open the mView programming

software, and the startup window will pop up when the application is opened,

as shown in the figure below. After the software is opened, it will follow the

menu bar [View] -> [Auxiliary Settings] -> [File]->Program automatically opens

the check box of the old project, to determine whether to start the last project

file when the software is opened, or not to open any file.

3.3. New HMI File

To create a new project, you can directly click [New File] under [File] menu,

Or click the icon in the toolbar, Or use the hot key Ctrl + N set by the

system. The dialog box shown below is displayed:
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Project Title: Enter the name of the new project;

Model Number: Select the model of the human machine interface (HMI);

(MX3G-43C selects model TP6043C; MX3G-70C selects model TP6070C)

Display Direction: Select whether the editing screen is displayed horizontally

or vertically;

Project help: Enter a help description for the newly created project, or you

can choose not to enter it.

After completing the project-related information input, click the [OK] button to

enter the communication information setting dialog box, as shown below,For

specific settings, please refer to Chapter 2.4.2 Communication Management of

"Coolmay TP Series HMI User Manual".
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3.4. TPWorks Program simulation

TPWorks editing interface layout:

Title bar: Displays the currently opened project path and file name,

window number, and window name.

Menu bar: A menu that displays various commands of CoolMayView.

These menus are all pull-down menus.

Standard toolbar: Shortcut buttons for placing some commands.

Corresponding buttons and editing tools for displaying files, editing,

printing and other functions.

Design components: Command buttons for component objects.

Screen management: The management window of the screen used by

the project.

Communication management: The project designer manages and sets

the window for communication with PLC or other serial devices.

Label management: Set labels for system variables and external
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variables to facilitate users to quickly find the corresponding variables.

Status bar: Display the current operating status, human-machine

interface parameters, and communication equipment.
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4. HMI program simulation and download

4.1. Program simulation

TPWorks provides the function of simulating directly on the PC. You can use

this function to simulate the actions performed on the HMI after planning HMI.

On the one hand, it increases the convenience of finding program errors, and

on the other hand, it can save downloading to the time HMI can connect to the

controller. The simulation function of TPWorks is divided into two types:

[On-Line Run] and [Off-Line Run], as shown in the figure below.

4.1.1. On-Line Run

This function needs to be connected to the controller, and the program will

modify the corresponding contacts and registers set by the controller during

execution. It can be used to verify whether the planned program can normally

act on the controller.

Before [On-Line Run], you need to set up the communication, as shown in

the figure below:

Among them, COM1 and COM2 on the left of [Communication Setup] refer
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to the communication ports on HMI, and the setting on the right is the set of

communication ports designated by the user on the PC side to simulate the

sex-corresponding communication ports of HMI side ,As shown below:

4.1.2. Off-Line Run

This function does not need to be actually connected to the controller, it can

be used to test the normal operation of the program and the verification of

various functions.

4.2. Program download and update O.S. version

After using the PC to simulate and verify that the program is correct, you can

start downloading to the HMI and directly use HMI to connect to the controller.

4.2.1. Download to HMI

Before downloading the program to HMI, you need to make communication

settings first, please select [HMI]→[Setup]→[Communication Setup], as shown

in the figure below:

Specify the communication port of the PC in the [Upload/Download] of the

communication setting window, that is, the port where the download cable is

connected to the PC. For example, COM24, you can select [Use fixed

communication rate] in conjunction with HMI [download screen], or let the PC

automatically try to download at different rates.

Then select [HMI] → [Download to HMI], and then start to download the

HMI program to the HMI, as shown below:
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4.2.2. Save as HMI program

In addition to downloading the planned program directly to the HMI,

TPWorks also provides the user to save the planned program as a specific file

(*.tpo) for later download and use. Note that this file is only for download and

use, and can no longer modify its content.

Select [HMI]→[Save To File...], save the project as a special HMI file of type

tpo., as shown in the figure below:

If you need to download this program to the HMI later, select [Tools]→

[Download HMI Program], as shown in the figure below, you can download this

program to HMI.
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4.2.3. Update HMI OS

Generally speaking, when the new version of mView software is updated, it

will be matched with the corresponding version of the OS. This OS supports

the old version of the planning software downwards, but if the user wants to

use the functions provided by the new version of the planning software, the

new version must be matched OS and HMI OS are updated as follows.

Step 1: Select [Tools]→[Update HMI OS].

Step 2: Select the OS version to be updated (it is recommended to update



COOLMAY MX3G PLC HMI All in one Programming manual

80

with the planning software version used).

Step 3: Start downloading. (Note: During the OS download process, the HMI

must can not be powered off!)

Step 4: After the download is complete, restart the power of the HMI.
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4.3. Program upload

Use this function to upload the program in the man-machine back to the PC

and save it as an HMI program for later downloading or editing by the user.

4.3.1. Upload HMI program

Select [Tool]→[Upload HMI Program] to upload the program from the HMI

back to the PC. After the transfer is complete, the user will be asked to save

the file as a dedicated file named tpo, as shown in the figure below:

To make the uploaded program editable, you must add the decompiled
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information before downloading the program, otherwise the uploaded program

can only be used for downloading, and the user cannot edit it.

Select [View]→[Option(H)]→[File], and tick [Add Decompiled Information].

As shown below:

4.4. For detailed usage of the HMI software, please refer to

"Coolmay TP Series HMI User Manual"

http://www.coolmay.com/webdown/TK_HMI_SYSC.pdf
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5. Appendix: Version Change Record

Date Changed version Changed content

Nov. 2021 V21.111  First edition released

Dec. 2021 V21.11  2.1 Soft element table, data register changed


